
SmartSoft-TOF Software Release Notes 
 

___________________________________________________________________________ 

 
Release 3.4.0 – October 2021 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

New nanoTOF 3 system type; 06-360P Pulsed Ion Gun; Bug Fixing 
 
NEW FEATURES 

Installation 
1. Automatic startup of the Configuration Setup application. Please select ‘Save’ after confirming 

configuration to make sure all the appropriate setting files will be set up correctly. 
 

Configuration 
2. System: Add the support for nanoTOF3.  
3. System>MS2>MS2 Picker Lookup Table: This allows the use of a lookup table to correct non-

linearity. If ‘Yes’ is selected for MS2 Picker Lookup Table, please place your copy of 
PickerLookupTable.csv in the C:\SmartSoft-TOF\Configuration folder. 

4. Stage>Hot Cold Stage: Add 20-311B for nanoTOF3. Please re-select your option. 
5. E-Gun Neutralizer: Add E-Neut Filament. The options are BaO, Ta, and Y2O3. Please select the 

correct filament type so the appropriate outgas routine will be performed. 
6. Gas Gun: Add the support for 06-360P. The new combination of pulsed low-energy electrons and 

low-energy Ar+ ions provide turn-key insulator analysis in both positive and negative ion polarities. 
7. Gas Gun>Gas Gun Control: Add the support for 20-068. 

 
SEE 
8. Sample and write consumable parameters like ion gun filament usage to the SEE database. 
 
UI 
9. New show/hide support with +/- buttons to customize the number of parameters to display. 
10. Ribbon>Queue>Queue Editor: Remove the obsolete ‘AutoTool Task’ view. Use Queue 

Editor>Utilities>Add Task… to add queue tasks. 
11. Ribbon>Queue>Queue Editor: Add the support for position list, data manager, and acquisition 

types.  
12. Ribbon>Queue>Queue Editor>Utilities>Sleep Until: The Sleep Until task allows the selection of a 

date and time to start the next queue task. 
13. Ribbon>Image Tool>Pulsed: Support pulsed imaging for Cesium and 06-360P Gas Gun. The 

resolution and scan rate for pulsed imaging can be adjusted in the Image Tool>Properties tab. 
14. Ribbon>Ammeter Tool>Picoammeter Range: Add selection of picoammeter range. 
15. Ribbon>Vacuum: Display only Intro and Main pressures. 
16. Ribbon>Stage: Add Absolute and Relative mode. 
 
Sample 
17. Auto Z: Streamline Auto Z setup by sharing acquisition setup like mass range and neutralization with 

main acquisitions. Provide the support for lower resolution to run Auto Z faster with one frame to 
improve the throughput. Provide the control of Transfer Lens voltage to have the analyzer cone 
contained within the field of view and centered. Display Auto Z dialog to show its image when Auto Z 
is launched. Added a new Centroid Algorithm for Weighted Average to use image moments 
calculation to improve accuracy in locating centroid. 

18. Stage>Properties>Limits: Show Platen: Max Z (mm) and Z (mm): Min/Max for Software and 
Hardware all in one place. 

 
TOF 



19. Profile>Interleaved: Support Gas Gun if the gas gun configuration is 06-360P. 
 

Hardware 
20. LMIG>Properties>LMIG Bi Source>Shutdown>Keep Tip Warm: The Keep Tip Warm mode is 

intended for reducing the emitter startup time by keeping the heater current at a warm value instead 
of zero when switching the LMIG mode from Ready to Standby. The hold time for Keep Tip Warm 
mode after setting heater current in emitter startup is much shorter than the regular hold time. ‘Warm 
Heater Current (A)’ specifies the heater current for the Keep Tip Warm mode. ‘Keep Warm Time 
(hr)’ specifies the timeout value before shutting down the tip to zero heater current. Switching the 
LMIG mode from Keep Tip Warm Standby to Off will run the shutdown routine to set the heater 
current to zero and take LMIG out from the keep tip warm mode. 

21. LMIG>Properties>Bi Recover…>Recover>Off Axis Test: Improve off axis test routine by waiting for 
emission current to reach within tolerance before averaging multiple sample current readings to 
improve accuracy and efficiency.  

22. LMIG>Properties>Bi Recover…>Recover>When Over Extraction or Refresh does not work, get out 
from the sequence without waiting for step 3a and step 3b when Stop is selected. 

23. LMIG: Add Raster Offset X/Y (um) for easy access. Support tuning for Lens 1 (V) and Beam 
Steering X/Y. For Bi source, set the lower limit for Lens 1 (V) to -10000.0 for protection. 

24. Cesium: Add Raster Offset X/Y (um) for easy access. 
25. C60: Add Raster Offset X/Y (um) for easy access. 
26. E-Neut: Add Ramp Rate (A/s) as part of E-Neut setting. Please resave all your E-Neut settings with 

an appropriate ramp rate. Implement different E-Neut outgas sequences based on the filament type. 
27. Gas Gun>Beam Energy: Add Raster Offset X/Y (um) for easy access. For the 06-360P 

configuration, limit the Beam Energy (kV) to 3kV and provide arc counts support in Diagnostics. 
28. GCIB: Add Raster Offset X/Y (um) for easy access. 

 
BUG FIXES 

Installation 
29. Correct the problem of running Custom Action multiple times when attempting to fix installation 

problem. 
 

Sample 
30. Auto Z: Correct the problem that the Auto Z state is stuck in running if Auto Z is selected again while 

it is in progress. 
 

TOF 
31. Phased Profile: Improve the robustness of using Cesium as the sputter gun by adding retry. 
32. Phased Profile: Correct a potential hanging problem of five minutes if stopping the phased profile 

during the sputter phase. 
 

Hardware 
33. LMIG>Properties>Bi Recover…>Refresh: For existing systems, please exit SmartSoft-TOF and 

modify C:\SmartSoft-TOF\Setting\PHI LMIG\Properties\Properties.phi as follows: 
Bi Emitter Over Extraction - Max Wait Time For Extractor Voltage (sec)=300  
Bi Emitter Over Extraction - Step 3 Emission Lock Max Extractor Ramp Time (sec)=300 

34. Cesium>Correct the logic to keep Cesium in Ready instead of Standby mode to keep it warm. 
35. E-Neut: Set the Standby mode filament current setpoint correctly using filament type. Set the 

setpoint to 0.9 A for BaO and Y2O3, and 1.2A For Ta. 
36. Gas Gun: Correct the problem that acquisition with neutralization is started before the emission 

current of gas gun is done ramping if the gas gun mode was off before starting acquisition. 
37. GCIB>Correct the problem that raster is turned off before completing blanking the gun. 
38. Firmware Wobble>Correct the problem that amplitude change is not applied in real time during 

wobbling. 
 
 
 



___________________________________________________________________________ 

 
Release 3.3.1 – July 2021 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

New Detector camera support; Bug Fixing 
 
NEW FEATURES 

 
UI 
1. Menu Bar>Hardware>System Configuration>Detector Camera: Add support for DMK22AUC03.  
2. Menu Bar>Hardware>System Configuration>System>MSMS>MS2 Detector Camera: Add support 

for DMK22AUC03.  
3. Configuration>Support customizable system name. 
 
TOF 
4. Acquisition>MS/MS: The lower limit for Precursor Mass (amu) is default to 80 amu. It can be set to 

between 68 amu and 80 amu. Please note that 80 amu was used to test electronics. 
5. Acquisition>End Mass (amu): The lower limit is changed to 100 amu. 

 
Hardware 
6. C60>Properties>Column: Add Stigmator Angle for adjusting rotation for optimization. 
7. C60>Properties>Column: Open the range for Stigmator Amplitude (V) to [-200, 200]. 

 
BUG FIXES 

TOF 
8. Chamber Camera: For DFK42AUC03, default video format to 'BY8 (1280x960)'; and frame rate to 

25.10'. Correct the problem that the chamber camera properties are not persisted after each 
SmartSoft session. 

9. Detector Camera: Correct the problem that the detector camera parameters are not persisted after 
each SmartSoft session. 

10. MSMS Detector Camera: Correct the problem that the MSMS detector camera parameters are not 
persisted after each SmartSoft session. 

 
 

Hardware 
11. Vacuum: Improve SVC reliability by adding recovery routine to address response mismatch issue. 

 
 
___________________________________________________________________________ 
 
Release 3.3.0 – August 2020 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Queue Editor Tool Palette; Bug Fixing  
 
NEW FEATURES 

UI 
1. Ribbon>Tool: Provide access to Queue and Queue Status. 
2. Ribbon>Tool: Make Vacuum Ribbon more compact to save space. 
3. Menu Bar>Automation>Queue Editor…: Rename AutoTool to Queue Editor. Add Tool Palette for 

simple utilities and hardware startup, shutdown, and outgas. 



4. Prompt for setting Cesium to Standby Mode at Startup: Give user the option to keep Cesium at 
Standby or switch to Off mode. If Standby mode is selected, PREVIOUS setting will be loaded. If Off 
mode is selected, ZERO setting will be loaded.  

 
System 
5. Vacuum>Improve pressure readback display to save space. 

 
Hardware 
6. Analyzer>MS2>Properties>Flight Time Calib: Change the calculation of Precursor start and end 

time in the Sequencer timing. Shift the time by half of Precursor Diff Offset (us). This change is 
backward compatible with V3.2.1 or earlier version of MS2 setting files. 

 
Installation 
7. Always use WinUSB drivers for USB devices. 
8. Provide a digitally signed WinUSB driver for PHI devices. Improve robustness of system setup by 

automatically installing this driver when installing SmartSoft-TOF. 
9. Report any installation problems including component registration by displaying Custom Actions log 

file when failure occurs. 
 

BUG FIXES 
 
PHI-FIB Configuration 
10. Correct the problem that PHI-FIB system hangs at start up. 
 
UI 
11. Ribbon>Tool: Do not change SED gain to target value when selecting tuning while imaging.  
12. Correct screen flickering that occurs when window group policies are being updated.  

 
System 
13. System>Sample Transfer: Remove Y axis limit validation for intro sample task or subtasks. Y is 

expected to move, and it should not prevent users from performing intro sample task. 
 

Hardware 
14. LMIG>Properties>Column: Correct the problem that Lens2 (V) DC cannot be edited at User level. 
15. LMIG>Tuning… button: Correct the problem that the Tuning button stays pressed after selection. 
16. LMIG>Tuning… button: Correct the problem that a warning dialog is always displayed when 

selecting the Tuning button while source tuning is running. 
17. Cesium>Properties>Raster: Add the missing Raster Size and Offsets X/Y. 

 
___________________________________________________________________________ 
 
Release 3.2.1 – January 2020 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Bug Fixing  
 
 

BUG FIXES 
 
TOF 
1. Phased Profile: When LMIG is selected as both the Primary Gun and Sputter Gun with the Use 

Settings option, correct the problem that Lens 2 voltage is set to zero when sputtering. 
2. SED Image Viewer: Correct the problem that Center Marker is not displayed regardless of its 

selection in the Image Properties. 
 



Hardware 
3. Outgas>Gas Gun: Correct the problem that emission current is not ramped if Gas Gun mode is Off 

when starting outgas. 

 
___________________________________________________________________________ 
 
Release 3.2.0 – October 2019 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Ribbon; Outgas Improvements; LMIG Tuning Tool; Bug Fixing  
 
NEW FEATURES 

UI 
1. Ribbon>Tool: Able to access Acq Status UI from Ribbon for optimized window layout. 
2. Ribbon>Tool: Provide access to Tuning Tool for LMIG and LMIG-2. 
3. Ribbon>By default, Ribbon is enabled with V3.2.0 software installation. 
4. Ribbon>Filament Usage: Provide a birdeye view of various consumptable usage like filament using 

battery views for maintenance cue. 
5. Menu Bar>Hardware>System Configuration>LMIG-2>Spectroscopy: Specify if LMIG-2 can be used 

as a spectroscopy gun. A second blanker/buncher box is required for the spectroscopy function.  
6. Menu Bar>Hardware>Open System Log…>Log File Analyzer: Provide a new option to update the 

log content periodically. 
7. Menu Bar>Automation>AutoTool…: Add Queue tree view to show startup, shutdown, and outgas 

sequence with limited editing functionality.  
8. Menu Bar>System>Zip Log File…: Have the option to include the last ten days of SEE data in the 

zip file. 
9. Prompt for setting GCIB to Standby Mode at Startup: Give user the option to bring up GCIB at 

Standby or Off mode. If Standby mode is selected, PREVIOUS setting will be loaded. If Off mode is 
selected, ZERO setting will be loaded.  

10. Prompt for confirming trace logging levels set to higher than the default level. This is to avoid 
excessive logging that is caused by a previous debugging session. 

 
System 
11. Vacuum>For systems with the LMIG-2 configuration, close the LMIG-2 Isolation Valve at Exit. 
12. Vacuum: Display a pressure readback as dashes instead of error when gauge or convectron 

readback has become out of range. 
13. Position List: Default Z height to 0.001 when positions are created on platen in Intro. 
14. USB Connection Monitor Support: Monitor and log messages in the system log when USB device is 

disconnected or connected. This is to differentiate the source of problems when communication 
errors occur. USB disconnect/connect indicate non-controller issues. 

 
TOF 
15. SED Image Viewer & Chamber Camera Viewer: Add “Lock” button to prevent unintended stage 

move when not running SED. The “Lock” button can be manually toggled to override the default 
behavior. 

 
Hardware 
16. Outgas Conditioning>Improve outgas with the following features: 

• Gauge selection – select the appropriate gauge for monitoring pressure 

• Recovery pressure – wait until pressure drops below this pressure before resuming outgas 
after pressure raises above the threshold pressure and reduction has to be performed 

• Hold time – specify the additional wait time after a supply outgas is complete 

• Details… button – show a preview for all the outgas parameters setup for the gun selected 



• Chart Recorder launch – automate the launching of chart recorder and saving of chart 
recorder outgas data 

• New Queue tree view display of outgas recipe in AutoTool – view outgas sequence and 
uncheck any unwanted outgas tasks 

• Improved outgas sequence with more automated support 
 

17. Auto Shutdown>Standardize auto shutdown for GCIB, Gas Gun, Ion Neut, E-Neut, C60, and 
Cesium. 
GCIB, Ion Neut, E-Neut, and Cesium support “Ready to Standby” and “Standby to Off”. 
Gas Gun supports “Ready to PARK” and “PARK to Off”. PARK means Standby mode with no 
emission and no gas. 
C60 supports “Ready to Standby”, “Standby to Idle”, and “Idle to Off”. 

18. LMIG>Tuning…: The tuning tool is for optimizing Beam Steering X/Y by centering the LMIG column 
image and optimizing Lens1 (V) by minimizing the size and sharpening the edges of the image in 
the SED Viewer. In the normal operation mode (i.e., not tuning), Beam Raster (%) is set to zero and 
only the Beam Steering X/Y values are applied to the gun. Users can launch the tuning by selecting 
the Tune button. In starting tuning, Beam Raster (%) will automatically be set based on the current 
LMIG raster size (% = 4000 / Raster Size (um)), raster waveforms are added to the steering values, 
and SED will be started. This feature requires jumper change in the 781 Deflection to apply raster 
waveform to the Quad Output connects used for source X/Y steering. 

19. LMIG>Properties…>Column: Add Lens 2 (V) DC setting parameter. The Lens 2 voltage is 
automatically set to the DC value when LMIG is in DC mode when performing SED, sputtering, and 
current reading. 

20. LMIG>MVA: Add “Industrial” and “FIB” options for Aperture Style. 
21. GCIB>If GCIB is not Off, set mode to Standby at exit to keep emission current and ionization voltage 

stable. 
22. E-Neut>Emission Current Readback: Display emission current readback in the main E-Neut UI. The 

reading interval can be adjusted. 
23. E-Neut>Diagnostics: Provide additional ADC readbacks. 
24. Gas Gun>Emission Current Readback: Display emission current readback in the main Gas Gun UI 

instead of showing Target Emission set point. The reading interval can be adjusted. 
25. Gas Gun>Diagnostics>20-066: Correct the unit for Filament Current readback to A. 
26. Analyzer>Analyzer>Sample Bias Voltage: Add wobble support. 

 
BUG FIXES 

 
Installation 
27. Correct the 64-bit installation that the wrong version of msvcrp100.dll and msvcr100.dll are included 

that may cause USB Cameras not functioning. 
 

System 
28. System>Intro Photo: Correct the problem where “GigE Camera” is displayed as the caption although 

the system is configured to have a Canon camera. 
 

Hardware 
29. LMIG: When there is a DSI shutdown event in bringing up SmartSoft-TOF, correct the problem that 

supplies do not remain as zero when loading a non-ZERO setting and LMIG mode is off after fixing 
DSI shutdown. 

30. LMIG>Properties>Column: Correct the problem that Raster X and Y Offset (um) are saved as zero 
in Beam Steering Raster mode (i.e., Beam Steering Raster (%) <> 0) when saving LMIG setting. 

31. LMIG>Diagnostics>General: Correct the problem that 10V Ref (V) is not updated unless SEE 
Database is activated. 

32. E-Neut>Remove target Emission (uA) to avoid confusion as E-Neut is run in manual emission mode 
by adjusting Filament (A). 

33. RBD Picoammeter Communication Problem: Correct the problem that prior USB power loss may 
cause SmartSoft-TOF unable to start with RBD communication problems. 



  
KNOWN ISSUES  

34. AutoTool Setting files generated by previous versions of SmartSoft-TOF are no longer compatible 
with the V3.2.0 software. Please take screen shot of the AutoTool setting files before installing 
V3.2.0 and regenerate them in V3.2.0. Please use AutoTool>Create>SHUTDOWN/STARTUP to 
regenerate the shutdown and startup sequence. 

35. Please re-set up your auto shutdown option for GCIB, Gas Gun, Ion Neut, E-Neut, C60, and Cesium 
as the options have changed. 

 
___________________________________________________________________________ 
 
Release 2.7.0 – October 2018 (Win7; 32-Bit) 
Release 3.1.0 – October 2018 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

SEE database diagnosis; New LMIG Bi-Single tip with improved Bi Startup routine; Bug Fixing  
 
NEW FEATURES 

SEE 
1. SEE: The System Evaluation Environment (SEE) is a new service utility built into the SmartSoft 

software which periodically records all system parameters while SmartSoft is running.   
Notes: By default, this utility is not active; and proprietary analytical data is never collected with 
SEE.  

2. Menu Bar>Hardware>System Configuration>System…>SEE: SEE data collection can be fully 
activated or deactivated in the configuration menu. 

3. Menu Bar>Hardware>System Log Setup…>Data Sampling: SEE data collection can be partially 
activated or deactivated for individual hardware devices by selecting Data Sampling.  Note that Data 
Sampling for individual devices is only valid when SEE data collection is activated in the System 
Configuration.  

 
UI 
36. Menu Bar>Hardware>Chart Recorder…: The Chart Recorder now includes an ‘Auto Scale’ feature 

which optimizes the data displays for all plots. 
37. Menu Bar>Hardware>Resource Monitor…: Add monitoring of C: hard disk space.  A warning 

message is displayed when the available disk space falls below an enterable threshold value. 
38. Menu Bar>System>Task Scheduler…: A ‘Once’ checkbox option is added to the task scheduler to 

limit the processing of the task to run only one time. 
39. Menu Bar>Hardware>Test Hardware…>: Auto fill the appropriate command options based on the 

selected device name to improve usability. Device command info is reformatted to improve 
readability. 

40. Menu Bar>Hardware>System Configuration>LMIG-1/LMIG-2>Emitter Type: Support new Bi-Single 
tip.  

41. Tool Window Dashboard: Able to access UI for Vacuum, Joystick, Stage, Image Tool, Ammeter 
Tool, and Sputter Tool anytime. 

42. Prompt for setting C60 to Idle Mode at Startup: Give user the option to bring up C60 at Off mode. 
43. Prompt for running Shutdown sequence: Give user the option to cancel any unintended shutdown. 
 
System 
44. USB Camera Model>Add support for DFK 42AUC03 UBS. 

 
TOF 
4. Data Manage>Lab Book: The lab book can now include an unlimited number for data file entries.  

Previous limit was 150. 
45. Phased Profile: Allow I-Neut for the charge comp phase and the sputter phase if sputtering at 

ground. 



 
Hardware 
46. DSI>Shutdown: Display additional information including ADC index, actual value, and expected 

value for easier problem diagnosis. 
47. MS2>Shutdown: Display additional information including ADC index, actual value, and expected 

value for easier problem diagnosis. 
48. LMIG-1/LMIG-2>New Bi-Single tip: For Bi-Single tip with 20-751, it runs emitter startup with 

controlled over extract to correct any off-axis problem. If emitter startup fails, it extends the waiting 
period to 60 minutes before automatically shutting down the tip, so users have a better chance to 
intervene. This is done by restoring the extractor current limit after 60 seconds and keep the tip in a 
a safer state while waiting. 

49. LMIG>Bi Source…>Startup>Step 1a Cold and Warm Hold Time (sec): Use different hold time 
depending on the elapsed time since last shutdown to make Bi Startup more efficient. 

50. LMIG>Bi Source…>Shutdown>Bi Warm Tip: Use this option to maintain a warm Bi heater current 
for an extended time period. 

51. LMIG-2-MVA: Add AutoTool tasks to do LMIG-2-MVA Drive All and Initialize. 
 

Service 
52. CommChecker.exe: A new utility called CommChecker is included in the SmartSoft-TOF\bin folder. 

CommChecker is used to check the communication channels as defined in the SmartSoft-TOF 
configuration properties file for trouble shooting purpose. 

 
 

BUG FIXES 
 
UI 
53. UI>Tab Stop: Tab stops are removed for all menus. 
54. UI>Menu Bar>System>Task Scheduler…: Fixed problem where the Task Scheduler incorrectly 

reports “AutoTool is already running”. 
55. Prompt for opening V7, V11, or V14 before operating LMIG-1, LMIG-2, or Cesium: Add the missing 

prompt for FIB, current measurement, and sputtering. 
56. Make Sample Bias selection: HV | GND| GND + Charge Comp consistent among Sputter Tool, FIB, 

and Phased Profile. 
57. File>Exit>Prompt user to confirm whether to shutdown LMIG source: Correct the problem that LMIG 

source is always shut down regardless of user response. 
 

System 
58. Sample>Position List>Z Position = 0.0: A default Z position of 0.0 indicates that the Z position is 

unknown at the time the position is created (e.g., platen not on the stage; import from defect file).  
Drive to Position ignores the Z move when the Z position is 0.0.  SmartSoft now displays a prompt 
which clarifies that a default value of 0.0 maintains the current Z position; while a value of 0.001 
drops the Z to a minimum Z position.  

59. System>Intro Photo>Take Intro Photo: Corrected the problem where taking intro photo is very slow 
and SmartSoft becomes unresponsive. 

60. Usb Cameras>Missing dll files: Include msvcrt100.dll and msvcp100.dll in the installation. 
 

TOF 
61. Acquisition: Correct the problem that acquisition hangs if DSI shutdown occurs during acquisition. 
62. Acquisition>Dose Calculation: Add multiplying of beam fraction to dose calculation. 
63. FIB: Do not keep toggling the LMIG Blanker Amplitude relay during the FIB routine to reduce 

overhead and unnecessary wear on the relay. 
64. Imaging: Correct the problem that restarting imaging using the Scan Speed button does not use the 

current Sample Bias Ground selection. 
65. Phased Profile: Sputter Phase>Sample Bias>GND: Correct the problem that the GND selection 

doesn’t ground the sample. 
 



Hardware 
66. Agilent Ion Pump Configuration: New channel assignment for Controller #2: LMIG-2 Source Ion 

Pump = Channel1; LMIG-2 Column Ion Pump = Channel2; Cesium Ion Pump = Channel3 
67. GCIB: Close GC0 and turn pressure control off when GCIB mode is standby or off. 
68. GCIB>Timed Sputtering: Correct timed sputtering failure if extractor voltage is greater than beam 

voltage. 
69. GCIB>Standby Mode: With PHI USA GCIB Control, correct the problem that high voltage is loaded 

after load setting. 
70. LMIG>Properties>Bi Recover…>Over Extract: Correct the problem that extractor voltage is not set 

back to nominal value at the end of the over extract procedure.  
71. LMIG>Properties>Extractor Limit (V): Correct the problem that the extractor voltage is ramped to the 

hardware limit instead of the software limit specified by Extractor Limit (V). 
72. LMIG>LMIG Properties>Column>Beam Steering Raster (%): Correct a firmware problem that sums 

the beam steering values based on the current image shift values. 
73. LMIG>Sensitivity Factor Calculation: Corrected the calculation using extractor voltage’s hardware 

limit instead of software limit.  The sensitivity factor affects the extractor voltage’s change rate in 
emitter startup. 

74. LMIG-2 Source Gamma Ion Pump Port number: Changed the port number from COM9 to COM4 to 
avoid a conflicit with Cesium port number assignment. 

75. TDC: Support the old TDC 915 model. 
 

KNOWN ISSUES AND LIMITATIONS 
76. If no Blanker/Buncher Electronics (DC FIB gun only), LMIG-2 should not be allowed as the 

spectroscopy gun to run spectral, profile, map, and image acquisition as the excessive signal can 
damage channel plates. 

 
___________________________________________________________________________ 
 
Release 2.6.2 – March 2018 (Win7; 32-Bit) 
Release 3.0.2 – March 2018 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Support Bi Emitter Off Axis Test, Over Extraction Recovery Process, and Refresh Recovery Process.  
 

NEW FEATURES 
Hardware 
1. LMIG>Properties>Bi Source…>Recover Tab>Support Bi Emitter Off Axis Test, Over Extraction 

Recovery Process, and Refresh Recovery Process. 
 

Off Axis Test 
Preliminary assumptions: LMIG is in the READY mode and L1; X/YBeamSteering; & MVA have been 
optimized for maximum column current. This test will measure column current at a low/high Emission 
Current and report a Pass/Fail status. Pass criteria is a (minimum current) & (minimum ratio at the 
low/high Emission Current). 
 
Over Extract Recovery Process 
Preliminary assumptions: LMIG is in the READY mode and L1; X/YBeamSteering; & MVA have been 
optimized for maximum column current & the Off-Axis Test has failed. This procedure will apply a high 
Extraction Field to the Bi tip to reshape the emission point of the Bi tip. Retries will be automatically 
performed. Bi source READY operation will be re-established, and a Complete or Complete-with-failure 
status will be returned. Final Extraction Voltage operation is the criteria used to establish Recovery 
Success. 
 
Refresh Recovery Process 



Preliminary assumptions: LMIG is in the READY mode and the Over Extract has not restored normal 
operation. This Procedure will re-heat the Bi tip while under an extremely high Extraction field to reshape 
the emission point of the Bi tip. Retries will be automatically performed. Bi source READY operation will 
be re-established, and a Complete or Complete-with-failure status will be returned. Final Extraction 
Voltage operation is the criteria used to establish Recovery Success. 

 
___________________________________________________________________________ 
 
Release 2.6.1 – December 2017 (Win7; 32-Bit) 
Release 3.0.1 – December 2017 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Bug Fixing  
 
BUG FIXES 
UI 
1. Menu Bar>Hardware>Bake>Increase the maximum value for Bake Time (Hours) and Cooldown 

Time (Hours) to 200 to allow for a longer bake. 
2. Menu Bar>Hardware>Sequencer>Diagnostics>Multi Pulser>Precursor>If necessary, widen the 

width (difference between Start and Stop time) to 80 ns to protect hardware. 
3. Menu Bar>Hardware>Sequencer>Diagnostics>Lock Button: A Lock button is added to the Single 

and Multi Pulser list, which, when pressed, prevents editing. The Lock button automatically gets 
pressed when running acquisition. This is to protect hardware during acquisition. For example, 
switching the rest state for MS2Buncher or Precursor could damage Mod 794/795. 

 
System 
4. Sample Transfer>Intro>Fix the problem of introducing sample with taking intro photo with GigE 

camera. 
 

TOF 
5. Spectrum/Profile/Map>Precursor Mass (amu)>Change the minimum value to 80. 

 
Hardware 
6. GCIB>Standby Mode>Modify the definition of Standby mode to include blanking the beam. This 

improves the transition from Standby to Ready mode to make sure the beam is blanked before 
ramping the beam voltage. 

7. LMIG>Properties>Extractor Limit (uA)>Disable this field for 20-750. Extractor Limit (uA) is supported 
by 20-751 only. 

8. LMIG>Filament Lifetime>Fix the problem of filament lifetime decreases after unexpected termination 
of SmartSoft-TOF. Filament lifeimte is logged in C:\SmartSoft-TOF\Settings\PHI 
LMIG\Logs\Filament Lifetime.phi. 

9. LMIG>Emitter Startup>Abort>Stop emission control loop when emitter startup is aborted. 
10. LMIG>Emitter Startup>Fix the problem of leaving the cursor spinning after emitter startup fails or 

aborts. 
11. LMIG>Emitter Shutdown>In shutting down, only ramp down the heater current. If Heater Shutdown 

Current is greater than the current heater current, do not perform any actions. 
12. MS2>Width Factor>Change the minimum value to 0.65. 

 
___________________________________________________________________________ 
 
Release 2.6.0 – October 2017 (Win7; 32-Bit) 
Release 3.0.0 – October 2017 (Win10; 64-Bit) 
___________________________________________________________________________ 
 



OVERVIEW 
Support for Windows 10; Agilent ion pump configuration; LMIG source bake; Integrated FIB; Dual LMIG; 
Bug Fixing  

 
NEW FEATURES 

UI 
1. Menu Bar>Hardware>System Configuration>Ion Pump: Support Agilent Ion Pump. This includes ion 

pumps for LMIG-1/LMIG-2 source, LMIG-1/LMIG-2 column, spectrometer, and Cesium source. 
2. Menu Bar>Hardware>System Configuration>Spectrometer Bypass (V12): Support pneumatic 

spectrometer bypass valve for baking LMIG source.  
3. Menu Bar>Hardware>System Configuration>LMIG-1>Bypass Valve(V13): Support pneumatic LMIG-

1 bypass valve for baking LMIG source.  
4. Menu Bar>Hardware>System Configuration>LMIG-2>Bypass Valve(V16): Support pneumatic LMIG-

2 bypass valve for baking LMIG-2 source.  
5. Menu Bar>Hardware>System Configuration>MSMS Precursor Selector: Support automated move 

of precursor selector position. It can be moved to the picker or Post ESA blanker position. 
6. Menu Bar>Hardware>System Configuration>LMIG-2 Type: Support dual LMIG. 
7. Menu Bar>System>Zip Log Files>Close down the dialog after zipping files. Reduce the key stroke 

as we usually zip up one file at a time. 
8. Service Shortcut: The installation creates a separate SmartSoft-TOF folder on the desktop and 

move the Service shortcut to this folder. A shortcut to the Configuration Setup program is also 
added to the folder. 

 
System 
9. Automation>Add MSMS V15 open/close to the startup/shutdown create sequence. 
10. Bake>Add the option to bake LMIG-1 or LMIG-2 source. This will reduce the bake time after LMIG 

tip replacement. Pneumatic V12, V13, and/or V16 bypass valves are required for LMIG source bake. 
11. Intro Glyph>Create Sample>R-Click on the Intro Glyph presents a dialog allowing the user to 

change the Sample Name. 
9. Pressure Log>Record intro, chamber, spectrometer, and LMIG pressure and write them to a file in 

the settings/log directory. 
10. Polarity Switch>Provide an action button to retry polarity switch if polarity switch fails. This also 

notifies users of any polarity switch failure. 
11. USB Camera Model>Support DFK 41BU02 in addition to DFx 41BU02. 
12. Tools>Sputter Tool>Charge Comp button and Charge Comp Properties dialog: Make it consistent 

with other tools and acquisition setups. 
 

TOF 
13. FIB>Support Integrated FIB. Support neutralization with standard Charge Comp button and Charge 

Comp Properties dialog. 
14. FIB>SED>Provide selectable green line for Mill, Polish, and Fiducial areas to reposition areas 

easily. 
15. FIB>SED>Context Menu>Undo (FIB): Provide an undo feature to easily correct an accidental 

mouse click on SED. 
16. Acquisition Setup>Add context menu to all start acquisition buttons to allow direct access to the 

Data Manager properties. 
17. Acquisition Setup>Charge Comp Properties>Add the option to do DC Beam Electron Neutralize in -

SIMS. 
18. Acquisition Status>Stop and Abort buttons>Update button hints to show if raw data file will be saved 

with the stop and abort actions. 
19. Start MSMS Acquisition: Provide an action button to open MSMS V15 if closed. 
 
Hardware 
20. Chart Recorder: This is a replacement for historical plot. Chart recorder supports setting files, 

plotting multiple supplies with scale factors, and customization of plot background color, line width, 
axes labels, data markers, etc. 



21. Diagnostics: Have the option of archiving periodic hardware diagnostics data for trouble shooting 
and system health check. 

22. LMIG>Bi Startup>Provide new parameters and routine for startup and shutdown. For Bi startup, add 
Step 1b and 3b. The change is backward compatible by using different parameters for different 
types of tips. 

23. LMIG>Properties>Extractor Limit (V): Move Extractor Limit (V) from Bi Startup to Properties. Use it 
as a limit for all extractor voltage input fields. 

24. LMIG>LMIG Properties>Column>Beam Steering Raster (%)>Support raster scanning of the 
Quadrupole Beam Steering X/Y plates. It controls the mag to oct ratio for the 781deflection. Please 
set image shift values to zero before modifying beam steering raster percentage. 

25. LMIG>Rename vacuum interlock to latched vacuum interlock. Latched vacuum interlock is tripped 
after vacuum interlock is fixed. 

26. LMIG>Display a dialog to notify users when vacuum interlock is tripped. Show the emission current 
as’--.--’ when interlock is tripped. 

27. LMIG>Prompt users when firmware lock is not available because of incorrect firmware version when 
SmartSoft-TOF starts up. The firmware version needs to be at least 1.3.5. 

28. Analyzer>DSI Diagnostics>Spectrometer>Hex Blanker>Clear>Add the Clear button to reset the hex 
blanker. The hex blanker needs to be reset every one to two months or when you start seeing a lot 
of TDC overflow errors. 

29. GCIB>Support Standby mode. In standby mode, all supplies are set to zero except for ionization 
voltage and emission voltage. 

30. Settings Editor>This can be used to view parameters, highlight polarity parameters, and modify 
parameters for all hardware.  

31. Copy Polarity>This can be used to copy parameters from positive polarity to negative polarity, or 
from negative polarity to positive polarity. This is supported by all hardware except for LMIG and 
Analyzer. 

 
BUG FIXES 
UI 
32. Menu Bar>Tools>Sputter Tool>Do not show red salient in status line when timed sputter is aborted. 

Abort is not an error. 
33. Menu Bar>System>Zip Log Files>Fix the issue of the dialog is hidden under SmartSoft-TOF main 

window. 
 

System 
34. Vacuum>Pump Intro>When there is an atmosphere leak and the pump intro task is aborted, 

increase the wait time from 5 seconds to 30 seconds to pump the high pressure out of the rough line 
before closing V6 and re-opening V5 to avoid dumping the system. 

35. Vacuum>Pump Intro>Add checking to make sure turbo is on (turbo speed > 50%) before switching 
to turbo pumping to avoid dumping the system. 

36. Vacuum>Properties>Correctly display yellow properties highlighting for “Wait Times”. 
37. Valve Viewer>ToolBar>Large Pressure Display: Add Cesium pressure to the display list. 
38. Intro Photo>GigE Camera>Fix issue with GigE camera so the camera doesn’t require ‘Device User 

ID’ set to ‘Intro’ to work. 
39. Tools>Sputter Tool>Improve error handling so it does not get stuck for five minutes when it fails to 

start E-Neut or I-Neut. 
 
Sample 
40. Chamber Camera Viewer>Chamber Camera Viewer Properties>Fix the problem of point & click’s 

move off by 90 degrees. 
41. Stage>Relative Drive Mode>Add protection to block slew moves while in relative mode. Slew moves 

are allowed only in absolute mode. 
42. Stage>Relative Drive Mode>Address the problem of not limiting Z height in relative mode and 

touching immersion lens. 
 

TOF 



43. Data Manager>Remove the limitation of 512 characters for MS1 and MS2 mass calibration peak 
strings in raw data file. 

44. Data Manager>Increase the precision for MS2 mass calibration parameters by recording these 
parameters with seven decimal point precision in the raw data file. 

45. Data Manager>MS2 Mass Calibration Peak List>Truncate peak list to only precursor mass when 
precursor mass is changed by at least 0.5 amu. 

46. Acquisition Properties>Detector Scan Mode>Use better default values.  Use Imaging 16x16 for 
spectral acquisition. Use Fast for profile and map acquisition.  

47. Acquisition Properties>Raster Pattern>Remove the 4-fold interlace patterning because of a 
hardware bug that causes missing data with the 64 and 128 resolution and 4-fold pattern. 

48. FIB>Make UI more intuitive. Dither out fields based on which mode (e.g., Mill, Polish) is selected. 
Add DC Current (nA) to FIB properties. 

49. FIB>Estimated Time: Make it more responsive and update time when FIB or FIB gun parameters 
change. 

 
Hardware 
50. Contention>Improve the scheme for hardware contention. This allows us to run simultaneous tasks 

more effectively (for example, running Bi startup while charting multiple hardware supplies) and 
have a more responsive UI. 

51. Analyzer>Properties>Spectrometer(S)>Post-ESA Slope: Fixed the problem of calibration when old 
analyzer setting files or raw data files are loaded with old intercept values.  

52. Analyzer>MS2>Properties>Mass Calib>Buncher (V)>Open up the range to [0, 10,000] to allow MS2 
mass calibration to work properly for all systems. 

53. LMIG>Properties>Filament Usage>Stop counting lifetime when LMIG vacuum interlock is tripped. 
When vacuum interlock is tripped, the controller returns the maximum value for emission current, 
which can greatly increase the value for Filament Usage (uA-hr). 

54. LMIG>PHI LMIG Emitter Status>Bi Startup>Correct update of readback values for suppressor and 
extractor voltages during Bi Startup.  

55. LMIG>Lens 1(V) and Lens 2 (V)>Correct the problem that lens 1 and lens 2 voltages are set to zero 
when SmartSoft-TOF starts up with firmware lock on and in -SIMS. 

56. LMIG>Diagnostics>Column>Rename Interlock Status to Sample Interlock Status. 
57. GCIB>GCIB Error>Display an error dialog to notify users of any GCIB interlocks. GCIB is turned off 

when an interlock is tripped.  
58. Gas Gun>Change emission startup dialog from Modal to Modeless so users are not locked out from 

the UI. 
59. Gas Gun>Clean up UI so the layout is consistent with other guns. 
60. Raster Size>The raster size dropdown list is now updated correctly to show the minimum and 

maximum selections for all guns. 
 
___________________________________________________________________________ 
 
Release 2.5.0 – December 2016 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.5.0:  Support 64-bit SmartSoft-TOF window program; Integrated Fast Zalar  
 
Note: This is the first version of SmartSoft-TOF that supports both 32-bit and 64-bit installations. The 64-
bit installation takes advantage of the larger memory address space and increased RAM size.  This 
allows the SmartSoft software to better handle large data files and increased pixel display resolutions. 

 
NEW FEATURES 

UI 
1. Menu Bar>Hardware>System Configuration>Fast Zalar: Support the Fast Zalar option if the system 

has a Hot Cold Stage. 



2. Menu Bar>Hardware>Detector Calibration…>Calibration File Name: Previous invalid ‘_’, ‘+’, ‘~’ are 
now allowed. 

3. Menu Bar>Automation>AutoTool>GCIB: Close Gas Valve. Customers can close the gas valve but 
keep GCIB in ready mode to keep the beam current stable for next day. 

4. Menu Bar>System>Zip Log Files: Allow zipping of system log files from a time period with Start and 
End. 

5. Menu Bar>Sequencer…>Diagnostics…>Abort: Abort Data Acq and TDCs. This may help if the 
acquisition hangs. 
 

Sample 
8. Stage>Fast Zalar: Allow Start and Stop of Fast Zalar (high speed rotation) if Sample Type is Fast 

Zalar. 
 
TOF 
9. Data Manager>Sample>Sample Type: Added a new Sample Type called Fast Zalar. 

 
Hardware 
10. LMIG>Properties…>Bi Source: Added a new field called Extractor Voltage Limit (V) for limiting the 

extractor voltage when emission control is regulated in Step 2, Step 3, and first part of Step 4.  It is 
default to -8000 for the new Bi tip.  If you are using the old Bi tip, please set it to -12,000V for 20-750 
or --15,000V for 20-751.  The limit for hold time for Step 1, Step 2, and Step 3 is increased to 
100,000 seconds. 

 
BUG FIXES 
UI 
11. Menu Bar>Hardware>System Configuration>Intro Camera: Make it backward compatible and 

doesn’t require users to re-select Intro Camera configuration. Previous Yes | No will be remapped to 
Canon | None. 

 
System 
12. Intro Photo>Take Photo: Prevent software hang caused by Auto Focus failure. If Take Photo detects 

an Auto Focus error, it will display an error instead of proceeding and waiting forever. 
13. Intro Photo>Calibrate>Calibrate Properties>Center Calibration Position: Hook up missing callback.  
14. Vacuum>Properties>Pump Intro Wait Time: Changed the maxium wait time from 60 minutes to 24 

hours to support gassy samples. 
15. Vacuum>Properties>Transfer Sample Main and Transfer Sample Intro: Remove these parameters 

as they were not used. 
16. Vacuum>Pump Intro: Do not open V4 if Pump Intro fails and cannot reach Intro Pre-Pump pressure. 
 
TOF 
17. FIB>Abort: Fixed beam damage by waiting for the sputter process to complete before restoring 

hardware parameters. 
 
Hardware 
18. LMIG>Load Setting: Block user from loading setting when sample is at Intro, stage is busy, stage 

aperture is busy or requires initialization. 
19. LMIG>Lens 2 Steering Y: Fixed the range to -100 to +100. 
20. C60>Load Setting: Block user from load setting if aperture requires initialization. 
21. Analyzer>Load Setting: Block user from loading setting when sample is at Intro.  When sample is at 

intro, HV is disabled, and won’t be able to ramp DSI supplies. 
22. Load Setting: Display load setting error with red salient on status line. 

 
___________________________________________________________________________ 
 
Release 2.4.0 – October 2016 
___________________________________________________________________________ 



 
OVERVIEW 

SmartSoft-TOF V2.4.0:  Support for new MS/MS and GigE Camera configurations; New Features; Bug 
Fixing  

 
NEW FEATURES 

UI 
1. Menu Bar>File>Restart TOF-DR: Re-establish communication with TOF-DR when TOF-DR 

becomes out-of-sync, hung, or crashed. This frees us from restarting SmartSoft-TOF, which may 
require shutting down of hardware. 

2. Menu Bar>Hardware>System Configuration>MSMS: Support parallel MS and MS/MS data 
acquisition. 

3. Menu Bar>Hardware>System Configuration>Intro Camera: Support GigE camera. 
4. Menu Bar>Hardware>System Configuration>GCIB: Support GCIB gun configuration.  The 06-2100 

has three turbo pumps and a magnetic coil.  The 06-2600 has two turbo pumps and a permanent 
magnet. 

5. Menu Bar>Tools>Sputter Tool>Raster Size (um): Allow editing of raster size of the selected sputter 
gun. 

6. Menu Bar>Tools>Sputter Tool>Sputter Time: Enter sputter time in seconds. 
7. Menu Bar>Automation>AutoTool>FIB: Support FIB mill/polish tasks. Customers can shut down the 

FIB gun when done and get e-mail notification. 
8. Menu Bar>System>Zip Log Files: Provide a tool to easily zip up system logs, application logs, and 

settings files for problem diagnostics. 
9. Menu Bar>Exit: If acquisition or SED is running, prompt users to confirm exit with shutting down of 

acquisition or SED. 
10. Menu Bar>Sequencer…>Diagnostics…>Sequencer>Save Bulk Data: Save raw bulk data for 

problem diagnostics. 
 
System 
11. Intro Photo>Properties…>Calibrate: The Intro Camera application now includes a simplified point & 

click interface which allows for drawing an area on the intro photo to calibrate the image.  This point 
& click interface is also available to define the clipping area.  Also new is the ability to import a BMP 
or JPEG image from and external camera source (e.g., an external microscope).  This import feature 
can also be used to recalibrate a previous taken intro “.pho” photo file. 

12. Valve Viewer>ToolBar>Large Pressure Display: The large pressure displays are shown in a sizable 
and movable window. 

13. Valve Viewer>GCIB: Show three turbo pumps for 06-2100 and two turbo pumps for 06-2600. 
14. Vacuum>Properties>Intro Ion Gauge: Add support to calibrate ion gauge at atmospheric pressure 

and system pressure. 
 

Sample 
15. Detector>Detector Camera: Add opening and closing of isolation valve (V7). 
16. Position List>Toolbar>Lock Button: A Lock button is added to the position list which, when pressed, 

prevents editing the position list. The Lock button automatically gets pressed when running 
AutoTool. 

 
TOF 
17. Data Manager>Properties>Filename>Ion Polarity: The auto file naming feature has been expanded 

to include polarity. Use ‘Pos’ for Positive Ions and ‘Neg’ for Negative Ions. 
18. Acquisition Properties: Support additional 64x64 and 128x128 acquisition resolution.  This will speed 

up acquisitions especially for mosaic map.  This feature requires DataAcq model 912 and TDC 
firmware update. 

19. Start Acquisition: Provide an action button to open V7, V8, V11, or V14 if closed. 
20. Spectrum/Profile/Map>Support parallel MS and MS/MS data acquisition for MS/MS equipped 

system. 



21. Spectrum>Properties>Spectrum>On Complete: Save RAW file at the completion of an acquisition.  
This can be used to avoid saving unnecessary files during alignment/tweaking/tuning. 

22. Spectrum>Properties>Spectrum>Save Spectrum File: Autosave Spectrum File (.tdc) at the 
completion of an acquisition. 

23. Spectrum>Properties>Spectrum>Save Profile File: Autosave Profile File (.dat) at the completion of 
an acquisition. 

24. Spectrum>Properties>Spectrum>Save Image File: Autosave Image File (.ims) at the completion of 
an acquisition. 

25. Spectrum>Diagnostics>TDC>Threshold:  Set minimum input pulse height accepted. 
26. Profile>Acquisition Status>Charge Comp: Show remaining charge comp time. 
27. Map>Mosaic Area>Maximum Tiles>Specify the maximum number of tiles. 
28. Charge Comp>Ion Neutralize with Gas Gun: Limit settings to neutralize settings. 
29. FIB> Continuously Variable Mill (CVM): Support a new milling process to mill descending slices 

approaching the face of interest like the polish process for better surface integrity. 
30. FIB: Broaden fiducial mark for better visual recognition. 
31. FIB: Integrated to SmartSoft-TOF.  This is a paid feature.  
 
Hardware 
32. Show gun errors for LMIG, C60, GCIB, Cesium, Gas Gun, Ion Neut, E-Neut in a consistent way by 

using red salient in the status bar. 
33. LMIG>PHI LMIG Emitter Status: Show both target and readback values. Add heater resistance 

readback. 
34. Analyzer/MS2>Fix ramping of supplies never complete by adding a 2-minute timeout. 
35. MS2>Properties>Mass Calib: Support viewing and editing of MS2 Mass Calibration parameters. 

These mass calibration parameters are saved in the raw data header. When MS2 spectrum is 
calibrated during acquisition, these parameters are updated in the UI and the raw data header. 

36. Gas Gun>Neutralize: Check the box and _NEUT will be appended to setting name to help 
differentiating neutralize settings from sputter settings. 

37. Gas Gun>Objective Lens: Support wobbling to tune 5-degree bend. 
38. GCIB>Properties>Source>Beam Ramp Rate (kV/sec): Ramp beam voltage slowly when switching 

to Ready mode. 
39. Hardware shutdown/interlock detected>Provide a clear button to clear shutdown or interlock when 

detected.  This includes LMIG vacuum interlock, DSI shutdown and MS2 shutdown. 
 
Others 
40. Use Service-TOF desktop shortcut to run SmartSoft-TOF in service mode.  This means everything is 

in simulation except for SVC and Varian ion gauge. 
 
BUG FIXES 
UI 
41. Menu Bar>Hardware>Bake>Bake Zones: Clean up the bake zone and strip terminology to match 

hardware. 
42. Menu Bar>Tools>Ammeter Tool>Faraday Cup: Do not lower Z and move stage to Faraday Cup 

position if stage is already at the Faraday Cup position. 
43. Menu Bar>Tools>Sputter Tool>Raster Gun/DEM Delay: Remove them as they were not used. 
44. Status Bar>Polarity: Positive (+) Ions/Polarity: Negative (-) Ions: Put up an hourglass to wait for both 

DSI and MS2 Supplies to settle. 
45. Status Bar>Error Message>Display acquisition, vacuum, and sample transfer errors with red salient. 
 
Sample 
46. Stage>Hot Cold: Stop regulating hot cold stage temperature once there are four consecutive 

sampling temperature errors. This is to avoid excessive use of CPU time to catch up temperature 
sampling. 

47. Stage>Hot Cold: Use backfill intro temperature limits instead of hot/cold warning limits for backfill 
intro temperature check.  



48. Stage>Hot Cold: Remove backfill temperature protection after pump intro is started so users don’t 
need to wait until intro pressure drops below 1.3E-2 Pa. 

49. Stage>Hot Cold>Properties>Relay and Sensor Type: Remove them as they were not used. 
50. Sample Transfer>Extract: Fix the problem of not able to backfill intro after transfer sample close V1 

and disallow any future vacuum tasks. 
 

TOF 
51. Large raw data file ASCII header: Remove the previous limit of 40K bytes. The symptom was no 

data display. 
52. Data Manager>Playback Raw Data File: Block launching of raw data file playback if acquisition is in 

progress. 
53. Data Manager>LabBook>Comment: Allow editing of comment.  The symptom was no data display 

in playback and the raw data file is corrupted.  
54. Data Manager>LabBook>Filename: The list of invalid characters now includes '~', '_', and '+'.  

SmartSoft-TOF uses '~' when a duplicate filename is found. The complete list of invalid characters 
is: '/\:*?<>|~_+'. 

55. TOF File Editor>Allow editing of ASCII header for raw data files. 
56. Profile>TDC Buffer error>Improve error handling so SmartSoft-TOF doesn’t hang after profile error. 

Depending on the cause of TDC buffer error, software may recover and continue on with the 
acquisition. 

57. Spectrum/Profile/Map>Restart: Disallow restart right after polarity switch. 
58. Spectrum/Profile/Map>Dose: Fix dose calculation. 

 
Hardware 
59. LMIG>Emitter Startup & Shutdown: Improve the robustness so startup and shutdown achieve a 

higher rate of success. Improve error handling. 
60. LMIG>Firmware lock: Limit sampling frequency (emission current and suppressor voltage update) to 

at most once every second to ensure software is responsive.  
61. Au and Ga Emitter Shutdown: Add turning off the heater. 
62. GCIB: With the support of 06-2600, we will skip the control of Magnet Current.  The symptom was 

having “burn fault” and emission current is not set correctly when switching gun mode or load 
setting. 

63. GCIB: Send down filament current limit when SmartSoft-TOF comes up. This is to ensure the limit is 
set to a known good value. 

64. KnobBox: When the KnobBox is configured but not connected (and not simulated); errors are 
continuously generated in the system log.  This bug will cause the hard drive to fill with log data over 
the course of a few days.  Protection has been added to log only one error in the system log on 
startup.   

65. WinUSB>Fix crashes at startup if USB devices are disconnected and not simulated. 
 

HELPFUL HINTS 
 

KNOWN ISSUES AND LIMITATIONS 
66. After installing V2.4.0, please run ConfigurationSetup.exe and reselect your Intro Camera option.  

Otherwise, you will get Create Session error.  
 
 
___________________________________________________________________________ 
  
Release 2.2.3 – March 2016 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.2.3:  Bug Fixing  
 

BUG FIXES 



 
Hardware 
1. Hardware>LMIG>Properties>Bi Source: Allow Normal Heat Current (A) to stay as greater than 3.8 A 

after restarting SmartSoft-TOF. 
2. Hardware>GCIB: In load setting or gun mode change, make sure emission current is sent down to 

hardware even if we have a burn fault. Protect the filament from being left on when turning the gun 
mode to off.  

 
___________________________________________________________________________ 
 
Release 2.2.2 – February 2016 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.2.2:  Bug Fixing  
 

BUG FIXES 
System 
1. Vacuum>Properties: Open up the range for Vent Intro to [1E+2, 1.01E+5] Pascal to support using 

Argon for venting. 
 
Hardware 
2. Hardware>LMIG>Properties: Open up the maximum value for Max Heater Current (A) to 4.0 A for 

Bi. 
 
 
___________________________________________________________________________ 
 
Release 2.2.1 – December 2015 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.2.1:  Adds MS/MS Support (hardware option); New Features; Bug Fixing  
 
NEW FEATURES 

UI 
1. Menu Bar>Tools>System Log: Backup copies of the system log are now stored in the C:\SmartSoft-

AES\Log directory 
2. Status Bar: The size of the status line fields can now be customized by clicking and dragging the 

edge of the field.  Fields can be returned to their default size by selecting the Reset Default Size 
option from the status line context menu. 
 

System 
3. System>Intro Camera: External image files (.bmp, .jpg) can now be imported and used to navigate 

on the sample.   
 
Hardware 
4. Hardware>LMIG: A new Settings Editor is available for viewing and editing the settings text files.  

The Settings Editor is accessed through a context menu from the Settings Box.  This Settings Editor 
is available for all hardware applications. 

5. Hardware>Ion Gun: The emission current startup ramping is optimized to improve the lifetime of the 
ionizer. 

6. Menu Bar>Sequencer>LMIG: Fine Delay (250pSec) values are now calculated as a function of 
coarse delay. LMIG: Quad, Buncher; C60: Pulser 2 
 

BUG FIXES 



 
UI 
7. Menu Bar>Hardware>System Configuration>Varian Gauge: The Varian gauge support is working. 
8. Hardware>C60>MVA:  Duplication C60 aperture settings from have been removed from the setting 

list. 
9. Hardware>Bake>Application Log: Duplicate entries in the Bake application log have been removed. 

 
Sample 
10. Sample>Stage>Hot Cold: Duplicate entries in the H/C Stage application log have been removed. 
11. Spectrum>Properties>Spectrum>Save RAW File On Abort: Data files are now saved when an 

acquisition aborts because of an error. 
 

System 
12. System>Sample Transfer: For protection, the Sample Bias and Immersion Lens are set to 0 V when 

a sample is moved to the intro position; and return to voltage when the sample is moved back to the 
analysis position. 

13. Sample>Sample Transfer: To improve the lifetime of the intro ion gauge, the ion gauge is disabled 
before backfilling intro; and re-enabled during pump intro. 

14. System>Sample Transfer: For protection, the Backfill Intro task now checks that V1 is closed, and 
that stage Z is at positive limit. 

15. Sample>Intro Camera: Communication reliability with Canon camera has been improved.  
 

Hardware 
16. Hardware>C60: Communication problems with the C-863 MVA aperture have been fixed. 
17. Hardware>C60: User ranges are read from the controller instead of using hardcoded manufacturer 

numbers. The effect is we do better calculate in converting between DAC numbers and user values. 
Also updated the calibration offsets so the read backs matched those from the manufacturer. 

18. Hardware>GCIB:  Tilt x, tilt y, rotation, and raster size calibration factors are now included in the 
GCIB settings.  Previous these values were properties. 

19. Hardware>GCIB: Baud rate for PHI GCIB control must be set to 9600.  The baud rate is now 
correctly set when this configuration is changed. 

20. Hardware>E-Neut: The E-Neut extractor voltage range is changed from [10, 75] V to [0, 75] V. 
21. Hardware>LMIG: Lens1 and Lens2 now use wobbling support found in the firmware; this is identical 

to what was done in previous version of WinCadence software. 
22. Hardware>LMIG>Properties>Raster: Mass Calibration Intercept field is difficult to edit because the 

field is displayed in scientific notation.  This has been fixed. 
23. Hardware>LMIG>Source Properties>Lock: Refresh Rate field is no longer used and has been 

removed. 
24. Hardware>LMIG>Schematic: LMIG labels for X and Y steering plates have been corrected.  These 

labels were inverted. 
25. Hardware>LMIG>Diagnostics: a 20-751 read back value was added for Extractor Limit DAC 
26. Analyzer>Spectrometer: the Post ESA Blanker value is now correctly set when in DC mode. 
27. Hardware>I-Neut:  I-Neut is now blanked when switching from DC mode to Ready/Off mode.  

Previously the bias voltage was set to 0.0, however this method did not effectively blank the beam. 
Gun is un-blanked when going back to DC mode. 

 
HELPFUL HINTS  
 
KNOWN ISSUES AND LIMITATIONS 
1. TOF>Spectrum: Acquisition appears to be running but nothing is displayed in TOF-DR.   

a) This problem is typically associated with a large raw data file ASCII header.  This should be verified 
by examining the file header in a WordPad style editor.  A fix is included in V2.2.1, which minimizes 
this problem. 

___________________________________________________________________________ 
 
Release 2.1.0 – February 2015 



___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.1.0:  20kV-C60 Ion Gun Supported as Primary Gun; Bug Fixing 
 
NEW FEATURES 
1. Menu Bar>System>E-Mail Notification: An e-mail or text message notification can be sent at the 

completion of an acquisition or AutoTool sequence.  Multiple notifications can be added to the AutoTool 
sequence to track the progress of the sequence.  Notifications can be sent to multiple e-mail addresses. 

2. Menu Bar>System>Coffee Timer: AutoTool tasks can be scheduled to begin processing at a specified 
day and time.  

3. Hardware>LMIG: LMIG 20-751 - The suppressor range for the 20-751 LMIG control is changed from (-
2000.0, 0.0) to (0.0, 2500.0).   This change is designed to improve the stability of the emission current 
during a long acquisition.   

4. Hardware>20kVC60: The 20kV-C60 ion gun is now fully supported as the primary ion gun. 
 
 
HELPFUL HINTS 
1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to another parameter 

field.  If the application is exited before the value is terminated the change will not be saved. 
            
KNOWN ISSUES AND LIMITATIONS 
 
___________________________________________________________________________ 
 
Release 2.0.0 – October 2014 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.0.0: Represent an extensive rework of the instrument control software for the 
nanoTOF II system.  This version is built using the SmartSoft architecture and implements many of the 
capabilities found in other SmartSoft products. 
 
For flexibility the data reduction software, TOF-DR, has been split from the instrument control software.  
This allows for efficient data reduction using TOF-DR on an off-line computer.  On the instrument TOF-
DR communicates directly with SmartSoft-TOF to display the data real-time.  Real-time data displayed in 
TOF-DR can be easily manipulated during data collection with no limitations.  

 
HELPFUL HINTS 
1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to another parameter 

field.  If the application is exited before the value is terminated the change will not be saved. 
            
KNOWN ISSUES AND LIMITATIONS 
            
 


